
 

 

 

 

 

 

 

T r a i n i n g  G u i d e  

7 – Font formatting 

Microsoft Word 2010 

– Level 1 



Microsoft Word 2010 - Level 1 

© Learning and Development Service Page 2 Font formatting 

FONT FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When your document comprises pages and pages of plain 
text, it can be very hard for your reader to find the 
important ideas buried in the page. You can improve the 
appearance and readability of your document by changing 
the appearance of the text – this is known as formatting.  

There are dozens of tools and facilities in Word to achieve 

this, giving you endless opportunities to make your text 
come alive. 

In this booklet you will: 

 gain an understanding of font formatting 

 learn how to use live preview 

 learn how to change fonts 

 learn how to change font size 

 learn how to grow and shrink fonts 

 learn how to make text bold 

 learn how to italicise text 

 learn how to underline text 

 learn how to apply strikethrough 

 learn how to subscript text 

 learn how to superscript text 

 learn how to highlight text 

 learn how to change case 

 learn how to change text colour 

 learn how to apply effects to text 

 learn how to use the format painter 

 learn how to clear font formatting 

INFOCUS 
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UNDERSTANDING FONT FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Font formatting refers to the appearance of 
text. You can change the format or 
appearance of text to make a particular 
phrase stand out, to make text more or 

less prominent, to indicate that the text is 

a quote, to reflect a particular mood or 
feeling, and to ensure that the overall effect 
is one of continuity and consistency. Text 
anywhere in a document can be formatted 

for any reason you like. 

Text in Documents 

Some of the simplest documents consist of text on a page. The text you use can be 
formatted to meet corporate requirements, to fit more on a page, to make it easier to 
read, to make it look like a flyer rather than a letter – it can be formatted for a wide 

variety of reasons. 

For example, you may like to change the font, font size, apply bold or italics, underline 
or change the colour of text.  

Text in Tables 

Text is used in tables, as shown here. The text can  
be formatted to show: 

Headings 

Normal table entries 

Quotes 

Samples and many other things... 

Text in Boxes 

Text can also be used in text boxes and other shapes (such as the example above). 

This text can also be formatted to match your document or as a caption for an image in 
a borderless text box, for example.  

Keep it Simple 

Formatting of text is best applied simply. Only make a limited number of changes 
unless your project specifically calls for more. A single overall font change can often be 
more effective than multiple changes that confuse or distract the reader. As a rule of 
thumb: 

 use no more than four formats on a page 

 reserve underlining for very special cases because it can interfere with the 
readability of text and imply a hyperlink 

 don’t use ALL UPPERCASE because it is not as easy to read as lowercase or 
mixed case and can be taken to imply SHOUTING 

 emphasise only the key words. 

Font Formatting Tools 

Because text can be added in so many ways to a document, it stands to reason that 
you will want your text formatting tools on hand wherever text appears. Font tools 
appear on the Home tab, in the Mini toolbar that appears when text is selected (as 
shown below), and when you right-click on text to display a shortcut menu. 

The tools work as: 

 toggles such as Bold , which is either on or off 

 single-use buttons such as Grow Font  which only ever do what their tool tip 

says 

 buttons to display a menu of choices, such as Change Case  

 multi-purpose tools such as Font Colour which can be used either to apply the 
displayed colour or to display a menu of alternatives . 

Callout boxes are 
another example of 

where text is used and 
can be formatted 
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WORKING WITH LIVE PREVIEW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To work with Live Preview: 
1. Select the text that you want to modify 
2. Point to the option that you want to 

preview 

3. Click on the option to apply it 

Handy to Know… 

 You can apply formatting to single 
letters or words by selecting them first. 
In this example, we could have used 
the mouse to drag across and select 
some of the text instead of selecting 

the entire text box. 

 Live Preview works with only some of 
the font formatting commands. 

Live Preview helps you to apply the right 
font formatting effect the first time, every 
time, by displaying a preview of the effect 
before it is actually applied. It gives you 

the chance to ‘test drive’ effects until you 

find the one you want, then you can select 
it. Live Preview changes the appearance of 
your text as you point to a font formatting 
option in a gallery or list. 

1 

3 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file W806 Font 

Formatting_1.docx... 

 In this example, all of the text 
appears in text boxes... 

1 Click in the introductory text to 
display the text box handles, 

then click on the edge of the 
text box to select it 

The dotted line between the 
handles will change to a solid 
blue line, and any changes you 
make will affect all of the text in 
the text box... 

2 Click on the drop arrow  for 

Font and then point to a font on 
the list 

The text will change appearance 
as the result of Live Preview.... 

3 Point to a few different fonts 
until you find one you like 

We’ve chosen Bradley Hand 
ITC... 

4 Move your mouse out of the 
menu and back onto the page 

Notice that the change is not 
permanent – you just get a 

sneak preview... 

5 Click on the font of your choice 

This will apply the font change 
and close the menu 
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CHANGING FONTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To apply font formatting: 
1. Select the text 

2. Click on the drop arrow  for Font 

3. Point to a font to preview it 

4. Click on the font to apply it 

Handy to Know… 

 You can jump directly to a font. For 
example, if you want to preview 
Garamond, click in the text box for Font 

and press . Word will jump to the 

fonts that start with the letter G and 

Live Preview will modify the text 
temporarily. Keep typing the name 
until you reach the font you want. 

1 

4 

The appearance that you choose for your 
text is referred to as the font or typeface. 
Font traditionally refers to a combination of 
typeface, style and size in points (e.g. Arial 

Bold 12 pt). In word processing, font just 
refers to the typeface or shape of the letters. 
Typical classic fonts include Times New Roman, 

Arial, Century Gothic and Copperplate. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 

the file W806 Font 
Formatting_2.docx... 

1 Click on Select  in the 

Editing group on the 
Home tab and select 
Select All 

All of the text will be 

selected. Notice that the 
Font group indicates that 
the font is Calibri (Body)... 

2 Click on the drop arrow  

for Font and point to a 
font  

The text will adjust to 
reflect a preview of the 
new font... 

3 Point to Arial Narrow, then 
Book Antiqua, Garamond 
and Gill Sans MT 

If you don’t have these 

fonts, try different ones. 
As you point to each font, 
the preview will change... 

4 Scroll down and click on 
Verdana, or another font 
of your choice to apply the 
change 

This time the font 
formatting is permanent – 
it won’t change again 
unless you make another 
selection 
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CHANGING FONT SIZE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To change font size: 
1. Select the text that you want to 

change 
2. Click on the drop arrow of Font Size  

3. Click on the required font size 

Handy to Know… 

 You may have noticed that the text 
didn’t change size when you used the 
Mini toolbar until you actually clicked 
on a different font size. This is because 
Live Preview doesn’t work with the Mini 

toolbar. 

1 

2 

One way that text can be emphasised is by 
changing the size of the font. For 
example, if your normal text is 11 pt, you 
may like to make the headings 13 pt or 

larger. Font size may also be changed for 

small detailed items, such as comments in a 
text box or a caption for a picture. Large text 
can be used in documents, such as flyers, 
and for cover pages. 

3 

4 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file W806 Font 
Formatting_3.docx... 

1 Click on Select  in the 

Editing group of the Home 
tab and select Select All 

This selects all of the text in 
the document (other than in 
text boxes and headers and 
footers)... 

2 Click on the drop arrow of 
Font Size  and point to 

14 

Live preview will display the 
text in a larger font size... 

3 Click on 10 to change the 
font size to 10 pt 

You can also change the 
font size of parts of a 
document, and you can use 
the Mini toolbar for this if 
you like... 

4 Using the mouse, drag down 
the left of the first address 
at the top of the document 
to select it then move back 
over the text to display the 
Mini toolbar 

5 Click on the drop arrow of 
Font Size and select 9 

6 Click away from the text to 
hide the Mini toolbar 
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GROWING AND SHRINKING FONTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W806 Font 
Formatting_4.docx... 

1 Click to the left of AGE 
Corporate Endeavours: 
Green Force Projects to 
select the line 

2 In the Font group, click on 
Grow Font  twice to 

increase the font size to 
12 pt 

The size is displayed in the 
Font Size control... 

3 Click on Grow Font  a 

few more times and see 
how the size increases 
each time 

Now to shrink it back... 

4 Click on Shrink Font  to 

reduce the size of the font 
until it is around 8 pt 

It should be a lot smaller 
than the surrounding 
text... 

5 Click on Grow Font  

until the font size reaches 
11 pt 

This is one point larger 
than the majority of the 
text 

 

For Your Reference… 

To grow the font: 
1. Select the text and click on Grow Font 

 until it reaches the required size 

To shrink the font: 
1. Select the text and click on Shrink 

Font  

Handy to Know… 

 The keyboard shortcut for increasing 
the font size is  +   (greater 

than). 

 The keyboard shortcut for decreasing 
the font size is  +  (less than). 

1 

2 

If you’re not exactly sure what font size 
you want and you just know that you want 
to make the text larger or smaller, you can 
grow or shrink the font. Grow Font  and 

Shrink Font  use the font sizes listed 

under Font Size. Each time you click on 
Grow Font, it changes the font size to the 
next larger size on the list. This is another 
way that you can test-drive different font 

sizes. 

3 

4 
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MAKING TEXT BOLD 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W806 Font 
Formatting_5.docx... 

1 Click to the left of AGE 
Corporate Endeavours: 
Green Force Projects to 
select the line as shown 

2 Click on Bold  which is 

located in the Font group 
on the Home tab 

The letters increase in 
thickness and intensity... 

3 Click away from the text to 
see the final effect 

This makes the subject of 
the letter easier to identify 

 

For Your Reference… 

To make text bold: 
1. Select the text 

2. Click on Bold  

Handy to Know… 

 Bold text is created by replacing the 
original letters with a darker, thicker 
version of them. Many typefaces, such 
as Times New Roman, have a series of 
typeface variations such as normal, bold, 

italics and bold italics. When you apply 

bold, Word replaces your normal 

typeface with a bold version of it. 

1 

2 

One of the most common ways of 
emphasising text is to make it bold. Bold 
text is darker in appearance because the 
letters are thicker, but it retains the same 

shape as normal text. The intensity of bold 

text draws the reader’s eye directly to it so 
that they read the most important 
information first. Like all formatting features, 
text must be selected before it can be made 

bold. 

3 
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ITALICISING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W806 Font 
Formatting_6.docx... 

1 Select the text Alpheuis 
Research Institute in the 
third paragraph 

2 Click on Italic  in the 

Font group on the Home 
tab 

3 Click away from the text to 
deselect it 

You can see clearly how 
the text slants to the right 

 

For Your Reference… 

To italicise text: 
1. Select the text 

2. Click on Italic  

Handy to Know… 

 It is recommended that you don’t use 
italics for long passages of text 
because the angle of the letters makes 
it harder to read than normal text. 

1 

2 

Italic text is a variation of a typeface that 
slants to the right. It was originally based 
on calligraphy and is used to emphasise 
words for a variety of special reasons. For 

example, you can use italics for book 

names, such as Murder on the Orient 
Express, scientific names such as Homo 
sapiens, foreign words such as in vitro, 
quotations, and unspoken dialogue in a 

novel. 

3 
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UNDERLINING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To underline text: 
1. Select the text 

2. Click on Underline  

Handy to Know… 

 Underlining should be used sparingly in 
documents because it makes text more 
difficult to read. It should only be used 
in web pages if it indicates a hyperlink. 
Underlined text will totally confuse a 

user if they click on it in a web page 
and nothing happens. 

1 

2 

An underline is one or more lines appearing 
immediately below text. Underlining was 
originally used to emphasise text in hand-
written documents, or to indicate special 

typographical treatment, such as italics, in 

documents that were typeset. These days, 
underlining is used primarily to indicate the 
presence of hyperlinks in online documents 

or for emphasis. 

3 

5 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W806 Font 
Formatting_7.docx... 

1 Select the text AGE 
Corporate 
Endeavours’ Green 
Force 

2 Click on Underline 
 in the Font group 

on the Home tab to 
apply a single 
underline 

3 Click away from the 
text to examine the 

underline 

You can also apply 
different forms of 
underlining... 

4 Double-click on 
November to select it 

5 Click on the drop 

arrow for Underline 
 and then point to 

different underline 
options 

Live preview will 
display each type of 
underlining as you 

point to it... 

6 Click outside the 
underline menu to 
close it without 
applying underlining 
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APPLYING STRIKETHROUGH 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W806 Font 
Formatting_8.docx... 

1 Select the text upon 
my return to 
Australia towards 
the bottom of the 
letter 

2 Click on 
Strikethrough  in 

the Font group on 
the Home tab to 
place a line through 
the text 

3 Click away from the 
text to display the 
result 

The advantage of 
strikethrough is that 
you can still read the 
text 

 

For Your Reference… 

To apply strikethrough: 
1. Select the text 

2. Click on Strikethrough  

Handy to Know… 

 Word has a feature called change 
tracking which monitors all changes 
made to a document. When change 
tracking is turned on and you delete 
any part of your document, Word 

applies strikethrough to the deleted 
text. 

1 

2 

Strikethrough refers to the placement of 
a line through text, as in strikethrough. In 
word processing, strikethrough allows you 
to cross out selected text without actually 

deleting it. It is particularly useful for legal 

documents and for making suggested 
changes to a colleague’s or student’s work, 
as the reader can see both the original and 
the amended text.  

3 
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SUBSCRIPTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W806 Font 
Formatting_9.docx... 

 

1 Click at the end of the 
third paragraph in the 
letter and type  

My thesis is entitled 
Sustaining H2O. 

2 Select the number 2 

3 Click on Subscript  

in the Font group on 
the Home tab 

4 Click away from the 
text to see the result 

The 2 is now clearly 
smaller and lower than 
it was before and 
forms part of the 

scientific name for 
water 

 

For Your Reference… 

To subscript text: 
1. Select the text 

2. Click on Subscript  

Handy to Know… 

 You can apply subscript as you type by 
pressing  +  before and after the 

character you want to subscript. The 
second time you press  + , 

subscript is turned off. 

1 

2 

Subscript text is text that appears below 
the normal position of letters and is slightly 
smaller in size, usually around ⅔  of normal 
text. It is usually used in mathematical 

formulas, for example, Zk+n,m = Zk,m and in 

chemical formulas and other scientific 
notations, such as ammonia, which is NH3, 
and methylene chloride, which is CH2Cl2. 

3 

4 
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SUPERSCRIPTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To superscript text: 
1. Select the text 

2. Click on Superscript  

Handy to Know… 

 Superscript is applied automatically to 
ordinals in Word, such as 25th. These 
settings can be viewed and changed by 
clicking on the File tab and then on 
Options. Click on the Proofing category 

and then click on [AutoCorrect 
Options]. Ordinals is found on the 

AutoFormat As You Type tab. 

2 

Superscript text is text that appears 
above the normal position of letters and is 
slightly smaller in size, usually around ⅔  of 
normal text. It is often used in 

mathematical formulas, for example, when 

expressing the powers of a number, e.g. 
2x2 = 22, and is also used for ordinals such 
as 2nd and 25th and in chemistry for 
variations in elements known as isotopes, 

such as 12C and 13C for carbon. 

1 

3 

4 

5 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W806 Font 
Formatting_10.docx... 

1 Click at the end of the 
third paragraph and 
type: 

There have been 

some particularly 
interesting studies 
lately in Boron 
isotopes 10B and 
11B as found in 
polar ice sheets. 

2 Select 10 

This is the first 
number than needs to 
be superscripted. We 
can actually select 
both numbers and 
apply superscript to 
them simultaneously... 

3 Hold down  and 

select 11 

Both numbers should 
be selected... 

4 Click on Superscript 
 in the Font group 

on the Home tab 

5 Click away from the 
text to deselect it 
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HIGHLIGHTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To highlight text, either: 
1. Select the text then click on Text 

Highlight Colour  

Or 
 Click on Text Highlight Colour  

and then click on the text 

Handy to Know… 

 You can remove highlighting by clicking 
on the drop arrow for Text Highlight 
Colour  and clicking on No Colour. 

 You can search for highlighted text by 
clicking on the drop arrow for Find , 

selecting Advanced Find, clicking on 
[Format] and selecting Highlight. 

2 

One formatting option that is used mainly 
online is highlighting. Highlighting places 
a coloured background behind text so that 
you can find it more easily or grab another 

reader’s attention. It’s the computer 

equivalent of using a highlighter pen and is 
great for editing or studying your own or 
other people’s work. Highlighting colours 
range from yellow to black. 

1 

3 

5 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or open 

the file W806 Font 
Formatting_11.docx... 

1 Select the text reducing 
greenhouse gas emissions 
in the second paragraph 

2 Click on Text Highlight 
Colour  in the Font group 

on the Home tab to apply the 
default colour to the text 

It should be yellow. You can 
also apply highlighting in a 
similar way to using a 
highlighter pen... 

3 Click on Text Highlight 
Colour  and then drag it 

across the text 

business process 
reorganisation 

Notice that the pointer 
changes and this time the 

colour is applied as you drag. 
You can also select different 
colours... 

4 Click on the drop arrow for 
Text Highlight Colour  

and click on Turquoise 

5 Drag the mouse across polar 

ice sheets to apply the 
colour 

6 Press  to turn off the 

highlighter 
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CHANGING CASE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W806 Font 
Formatting_12.docx... 

1 Click to the left of the 
heading AGE Corporate 
Endeavours: Green 
Force Projects to select it 

2 Click on Change Case  

and select Sentence 
case. 

All of the capitals, other 
than the very first one, will 
change to lowercase... 

3 Click on Change Case  

and select UPPERCASE 

This time all letters will 
change to capitals... 

4 Click on Change Case  

and select tOGGLE cASE 

This will change all of the 

uppercase letters to 
lowercase (and vice 
versa)... 

1 Click on Change Case  

and select Capitalise 
Each Word, then change 
Age to uppercase 

This will convert the letters 
back to a form more 
suitable for a heading 

 

For Your Reference… 

To change case: 
1. Select the text 
2. Click on Change Case  

3. Select the required case 

Handy to Know… 

 Text typed in all UPPERCASE letters is 
rarely used as it is harder to read (as 
there’s no shape variation) and because 
uppercase can be interpreted as shouting 
when used in correspondence. All 

uppercase is best reserved for short 
headings or headlines which appear in 

much larger font sizes. 

2 

Case refers to whether the uppercase 
(capital) or lowercase form of a letter is 
used. Microsoft Word allows you to change 
between cases so that you don’t have to 

retype text. Change case options are 

Sentence case, where the first letter is a 
capital, lowercase, UPPERCASE, 
Capitalise Each Word, and tOGGLE cASE, 
which swaps between upper and lower case. 

1 

3 

4 

5 
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CHANGING TEXT COLOUR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W806 Font 
Formatting_13.docx... 

1 Double-click on AGE in the 
first paragraph to select it 

2 Click on the drop arrow for 
Font Colour  to display 

the colour palette 

3 Point to different colours 
and see the effect on the 
text 

Live Preview will update 
the display... 

4 Point to Green under 
Standard Colours 

The tool tip will display the 
name of the colour so that 
it’s easier to find... 

5 Click on Green to apply 
the colour to the text 

6 Click away from the text to 
deselect it and display the 
result 

 

For Your Reference… 

To change text colour: 
1. Select the text 
2. Click on the drop arrow for Font 

Colour  

3. Click on the colour of your choice 

Handy to Know… 

 Once you have selected a colour, it will 
appear in the actual Font Colour tool. 
You can then click on the tool rather 
than the drop arrow to apply the 
colour. 

 You can remove a font colour by 
clicking on Automatic. 

4 

The colour of text can be changed to any 
colour that you select from the wide 
ranging palette. Colour can be used to 
reflect a corporate brand identity, to reflect 

the mood of a document, or to just jazz it 

up a bit and catch the eye of a passerby. 
With colour, as with many of the other font 
formatting features, less is more – use too 
many colours and you will just confuse the 

reader. 

1 

5 

6 
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APPLYING TEXT EFFECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W806 Font 
Formatting_14.docx... 

1 Click to the left of the 
heading AGE Corporate 
Endeavours: Green 
Force Projects to select it 

2 Click on the drop arrow for 
Text Effects  to open 

the text effects palette 

3 Point to different options 
and see the effect on the 
text 

Live Preview will update 

the display… 

4 Click on Gradient Fill – 
Purple, Accent 4, 
Reflection 

This option is found in row 
4, column 5…  

5 Click away from the text to 
see the result 

 

For Your Reference… 

To apply a text effect: 
1. Select the text 
2. Click on the drop arrow for Text 

Effects  

3. Click on the option of your choice 

Handy to Know… 

 Rather than selecting a predefined text 
effect, you can apply an outline, 
shadow, reflection, glow, or a 
combination of these options. To do 
this, select the desired option from the 

base of the text effects palette which 
will in turn open a further palette of 
options.  

 

2 

Microsoft Word enables you to apply 
various effects to selected text. For 
instance, you may want to use a fancy 
heading in a flyer or apply eye-catching 

effects to the text on a birthday invitation. 

Using the options available in the text effects 
palette, you can apply visual effects to text 
such as shadows, glows, reflections or 

outlines. 

1 

5 
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USING THE FORMAT PAINTER 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To use the format painter: 
1. Click in the formatted text 
2. Click on Format Painter  

3. Select the text to be formatted 

Handy to Know… 

 If you double-click on Format Painter 
 you can keep pasting the format 

until you press  or click on Format 

Painter  again. 

 When you paste a format it will replace 
any previous font formatting. 

3 

The process of formatting text in Word 
involves first selecting the text to be 
changed and then applying the formatting. 
If you have a lot of changes to make, this 

can become quite laborious and difficult to 

reproduce exactly. Fortunately, Word has a 
tool called Format Painter that allows you 
to copy the formatting of text from one place 
to another.  

1 

6 

7 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or open 

the file W806 Font 
Formatting_15.docx... 

1 Select the text Sustaining 
H20 in the third paragraph 

2 Click on Bold , Italic  and 

then click on the drop arrow 
for Font Colour  and click 

on Blue under Standard 
Colours 

3 Click away from the text so 
that you can see the 
formatting 

If you had to repeat these 
formatting steps several times 
it could become quite tedious. 
Instead, you can copy the 
formatting from this text to 
other words... 

4 Click back in the formatted text 

You don’t need to select it... 

5 Click on Format Painter  in 

the Clipboard group on the 
Home tab 

The mouse pointer will change 
to a paint brush... 

6 Drag across the text Alpheius 

Research Institute to apply 
the formatting 

7 Click away from the text to see 
the result 
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CLEARING FONT FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To clear all formatting: 
1. Select the text 
2. Click on Clear Formatting  

or 

 Press  +  

Handy to Know… 

 Clear Formatting  changes text back 
to the default settings specified in the 
Font dialog box. It does not affect 
settings that don’t appear in the Font 

dialog box, such as Text Highlight 
Colour. 

4 

If you decide that the formatting applied to 
text actually makes it more difficult to 
read, or you’ve accidentally applied 
formatting that you don’t want, you can 

clear the formatting. You can reverse some 

formatting effects by using the same tool 
that you used to apply the effect, or you can 
remove all formatting and return text to its 
original normal state using the Clear 

Formatting tool. 

1 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this exercise 
you MUST open the file 
W806 Font 
Formatting_17.docx... 

1 Examine the text 

It has had many formatting 
changes applied to it, 
including font and font size 
as well as some special 
formatting effects... 

2 Click on Select  in the 

Editing Group on the Home 
tab and select Select All 

3 Click on Clear Formatting 
 to return the text to 

Calibri 11 pt and remove 
the font formatting effects 

4 Click anywhere in the 
document to deselect the 
text, then scroll down to 
examine it 

All of the font formatting, 
except for the highlighting 
has been removed... 

5 Select reducing 
greenhouse gas 
emisions, press  and 

select business process 
reorganisation and polar 

ice sheets 

6 Click on the drop arrow for 
Text Highlight Colour  

and click on No Colour 

The text is returned to its 
original format 

 



Microsoft Word 2010 - Level 1 

© Learning and Development Service Page 20 Font formatting 

CONCLUDING REMARKS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Congratulations!  

You have now completed the Font formatting booklet.  This booklet was designed to get 
you to the point where you can competently perform a variety of operations as listed in the 
objectives on page 2.  

We have tried to build up your skills and knowledge by having you work through specific 
tasks. The step by step approach will serve as a reference for you when you need to repeat 
a task. 

 

Where To From Here… 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills 

that you have acquired and use some of the application's commands. This will test 
just how much of the concepts and features have stuck! Don't try a big task just yet if 
you can avoid it - small is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points 
that you may be unclear about. Use the examples and exercises in these notes and 
have another go - these step-by-step notes were designed to help you in the 
classroom and in the work place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 visit CLD’s e-learning zone on the Intranet  

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities, browse the Internet, specifically the technical 
pages of the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we 
don't suggest that you plagiarise but you can certainly learn from the techniques of 
others 

 if your software came with a manual (which is rare nowadays) spend a bit of time 
each day reading a few pages. Then try the techniques out straight away - over a 
period of time you'll learn a lot this way 

 and of course, there are also more courses and booklets for you to work through 

 finally, don’t forget to contact CLD’s IT Training Helpdesk on 01243-752100 
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